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1 GAMS version 26.1.0 
Within the last couple of weeks we saw a new GAMS release.  Here I comment on some of its 
features.  Note I am no longer updating the McCarl Guide so for more information see the 
official GAMS guide accessible on the web through the IDE of through Studio. 
 

1.1 Implicit set definition 
GAMS has now introduced a way of implicitly defining set based on the names used in data 
input.  One does this at compile time (so the set can be used in defining domains).  This is done 
for example by using a new syntax feature which involves inserting one or more ​< ​'s as follows 

Set     I set to be implicitly defined 

        J another set 

* Below the ​<​ tells GAMS to draw the set elements for I and j from  
*     the elements associated with data in a 

Table a(I ​<​,j ​<​)  
         J1        J2 

I1        4        3 

I2        7        4; 

Display I,j; 

 

The ​<​ can be used more than once in conjunction with ​$onmulti ​which ​merges​ in new entries or 
the new command ​$onmultiR ​which ​replaces​ the previous set definition. 
 

1.2 Put Utility to select solver 
A new ​put_utility​ keyword ​solver​ was added that allows one to select a solver for a particular 
model type or all possible model types.  An example follows 

Set  slv solvers to use in solving the MIP /CPLEX, ​ ​mosek,xpress/; 
*loop solving with each of these solvers 

loop(slv, 

   ​put_utility 'solver' / 'mip' / slv.tl:0; 
   solve mymodel using mip maximizing myobjective; 

); 

 

Additionally the command to use a solver in this case Conopt for all applicable models it can be 
applied to is  

   ​put_utility 'solver' / '*' / 'Conopt';  
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1.3 Handling of spaces in file names and commands 
GAMS was altered to better accommodate spaces in file and directory names plus eliminate 
associated error messages. Simultaneously the reading of command-line arguments on 
non-Windows platforms was also changed to better accommodate spaces and eliminating the 
need for extra quoting. 
 

1.4 Solver updates 
A lot of solver updates were added with what appears to me to be significant new features or 
improvements added for Baron, Conopt 4 , Kestrel, Knitro, Lindo/LindoGlobal, LocalSolver, 
OdhCplex, Path, Scip, SoPlex and Xpress.  Also a new solver called Selkie was introduced 
which is an EMP problem type solver that implements decomposition methods for multi-agent 
equilibrium and related models.  
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2 A new release of GAMS Studio 
The most recent release contains a substantial upgrade of GAMS Studio.  Below I discuss what I 
consider to be important elements of this version of Studio. 

2.1 Includes a reference file viewer 
A few years ago I worked with the GAMS staff to create a viewing/navigation procedure to help 
a user unravel the location and use of parameters, sets, variable, etc. This was designed for use in 
the context of a GAMS implementation with multiple include files and was implemented in the 
IDE.  As of this release, Studio contains this feature.  The basics function is discussed in the 
Studio or GAMS IDE documentation under the topic Reference File Viewer or more extensively 
in the McCarl Guide under the topic Refreader. To access the McCarl guide treatment go to 
https://www.gams.com/fileadmin/community/contrib/doc/mccarlgamsuserguide.pdf​  and use 
search to find Refreader. 

Briefly one accesses this feature by  

1. Running a job with the added command line instruction rf=​myname​ which creates 
the file ​myname.ref​.  Note the file name is chosen by the use so rf=​list​ is also 
possible resulting in the file ​list.ref​.  GAMS adds the ref extension if it is not in 
the file name. 

2. Opening the ref file by clicking on a blue line in the output window that starts 
with RefFile.  This can also be directly opened using the file open dialogue. 

3. Navigates the files included in the model using a window like that below (where 
the run used the GAMS file rf=list yielding list.ref. 

 
An example was created using the McCarl guide example file ​transint.gms​ that integrates three 
other files. Note the run used the GAMS command line entry ​rf=list ​yielding a ​RefFile ​named 
list.ref. ​ On my machine the​ ​transint.gms ​file is located in ​C:\GAMS\win64\26.1\mccarl. ​ The 
command line entry in Studio is pictured below as is the output file with the clickable link  
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Then after running one clicks on the ​RefFile ​entry opening the ​list.ref​ file as below 

 

Within the list.ref window in Studio there are ​lines​ that when clicked on cause Studio to open 
some lists of things appearing in the model.  These include a list of all symbols; lists that when 
opened contain information on sets, parameters etc.; a list of items that are defined but never use 
and finally a list of the files used.  When activating these lines (tabs) the window then contains 
detailed ​lists of items​.  In the left part of the screenshot below these list all items in the model 
defined that are parameters.  Subsequently when one clicks on an item name (in the screenshot 
this was the first one -  CMOVEMENT) then one gets a ​list of file and line locations where 
that item is declared, defined, assigned​ etc. Clicking on that list opens the associated file to the 
appropriate location. 

 

There are a couple of aspects of this meriting comment. 

● The all items window is squeezed vertically and still contains the explanatory text but it 
is hidden. To see it one must manipulate the display widening and narrowing columns.  It 
may be advantageous to reorder it.  I would prefer the explanatory text to be just after the 
item name.  

● As of now Studio does not have the right click option of writing a CSV file containing 
this information and I hope this is added as it has been useful in creating model 
documentation. 

● Studio provides access to all the locations in a file where a category of use of an item 
appears.  The IDE just opened the file and positioned the cursor at the first one and 
assumed further navigation would be done via the editor.  The Studio approach may well 
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create long lists in some cases perhaps hindering easy navigation and may or may not 
turn out to be an advantage. 

● There is an aspect of the reference file design that influences the contents of the list of 
files used that affects the output in both the IDE and Studio.  In particular if a file  is 
included without any GAMS keywords it will not be listed.  For example the file 
dataforimport​ in the example below would not be in the list of files. 

Parameter datatoimport(mysets) / 

$include ​dataforimport 
/; 

 

2.2 An improved version of GDX viewer 
The GDX file viewer in Studio is now improved with inclusion of a table viewer and some 
manipulation possibilities.  This supports user directed opening of a ​GDX file​ and facilitates 
examination of its contents.  On selection of an item in the GDX file the viewer generates a list 
or a table based representation (depending on whether list or table view is chosen at bottom). 
Under table view only items with 2 or more dimensions are displayed with the last dimension put 
into the header of the table. The IDE capabilities of dragging and dropping of items and 
reordering where sets appear is not currently available, but is planned for the future.  As in the 
last version, Items can be sorted alphabetically or from small to large by clicking on the​ tabs as 
in the windows explorer​. 

 

Table view also permits columns to be reordered via drag and drop. Additionally in List view 
one can choose to suppress display of set elements using the  symbol and when elements are 
suppressed they do not appear in the Table view. Finally a right click allows writing of a selected 
section of the list or table view to CSV files.  
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2.3 Solver choice, license status information moved 
In the IDE one chose solvers and found license information under file and settings it is now in 
the Help>About GAMS dialogue with solver choice under the solvers tab.  In the IDE different 
setups could be used across projects. This is not possible within Studio and would need to be 
embedded in model specific files. 
 

2.4 Command line editor 
GAMS contains many possible command line entries. A new feature that has been added to 

Studio is the command file editor. This is accessed by pressing the box labeled with  that 
appears on the right-hand side of the Studio window  

  

When that box is pressed than the command line editor expands as follows 

 

where the commands that are now being used ​in the command line box​ appear in the ​left side of 
the window​ and the ​possible command line entries are listed within the right​ window. Also if one 
goes into the box ​labeled search option​ and starts typing characters then the commands listed in 
the right-hand window will only be those which contain those characters. Once an option has 
been found if it is selected and F1is pressed then documentation on that option is displayed. 
Also if one wishes to change the value for it then when it has a presecified set of choices a gray 

>​ symbol will appear beside it.  In turn, when that is clicked on a dropdown menu of alternative 
values and their meaning appears.  Then when one double clicks on a choice or the option name 
as it is designated as a changed option and is placed in the ​left hand box​ and in the​ command 
line​. In the left-hand box one can select the value in the cells underneath the ​value column and 
change it if desired​. I found the mouse operations a little strange to work with but if you restrict 
your operations to the cells falling under the value column and either make choices or start 
typing then you can make changes.  
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2.5 Defining your own library 
In my teaching I find it valuable to have my own library of examples.  Years ago I participated 
with GAMS staff in the development of a way that a user could set up their own library creating 
a "glb" file then permit access to it through the IDE.  This is discussed in the document ​Creating 
a User Library for use in the IDE​. This is now supported in Studio.  To provide access one needs 
to place the glb file in a specific file location that varies across platforms. That location can be 
identified by navigating through the File>Settings>Misc>Open Location dialogue then one can 
subsequently place the glb file there. Also note that within the GLB file there is an entry for 
LibraryName ​which is the name that will be used to identify the library in the GAMS Library 
Explorer. 

Version = 5 

LibraryName = McCarl Class.glb 

Columns = 4 

1 = Name 

2 = Notebook Section 

 

I also think there is room for improvement in the Library Explorer access procedure.  In 
particular I feel that it is unnecessary to include the glb file extension in the library name and 
also that it would be nice to allow the user to reorder the list of accessible libraries plus collapse 
items from that list that are of little interest into one aggregate "other" category.  For example 
given the possibility I would collapse the ones from Test Library through PSO Library into an 
others tab and would move McCarl Class up toward the front. Such a choice would clearly differ 
from user to user. 
 

2.6 Option to jump to first compilation error  
For a long time I have wished that GAMS would reposition the LOG and LST files to the first 
error message when compilation errors appear. There is some progress in that direction in Studio 
with options controlling behavior in File>Settings>General although for now there seems to be a 
bug in this as I was told "​If you check the ​Jump to the first compiler error option​ and uncheck 
Open lst file after run​, it actually works, and you jump to the first error in the gms file. But if 
both are checked, nothing happens." ​ This results in the cursor being repositioned to the place in 
the original GMS file where if you hover over the  then the error message appears as follows 
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Also I would note that I think it would be better if the log file was always repositioned to the first 
error message) as it allows better navigation when there are multiple relevant error messages that 
are not in close proximity in the GMS file. 
 

2.7 What is in Studio?, What is not? and What could be improved?  
There are a number of features in the IDE that are not in Studio or vice versa plus things I like 
and things in my very limited Studio use that I find annoying or potential subjects for 
improvement.  

Those uniquely in the IDE​ ​are​: 

● Ones I judge to be of substantial use that I would like to see come into Studio - Option 
file editor; Find in files; Option to delete 225a directories; More powerful GDX viewing; 
Permanently visible run button and command line box (not controlled by checking the 
View> option line); Menu driven GDX file differencing; Ability to choose default 
solvers; and Means for adding default contents to command line in the 
File>Setting>Execute command. 

● Of lesser value but still convenient - Ability to manipulate syntax coloring; Ability to use 
alternative GAMS versions at execution time (maybe not until Studio is stable); More 
context (project or default) specific solver selection menu and Ability to stop MIP solves 
by the user through the process window.  I also found occasional value in Menu driven 
Text differencing; and Spell checking. 

● Things I am glad are gone – Script recording (the scripts never worked right for me due 
to possible project changes) and Chart creation in the GDXviewer (I thought it did not 
work well or give enough user control).  

Those uniquely in Studio are: 

● Ones of substantial use: Help integration through the F1 key; Automatic insertion of 
closing character for brackets and quotes; Command line parameter editor; Option to 
jump to first compilation error (as covered above); Writing of less files to disk (optionally 
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no LOG); GDX viewer sorting/element suppression; and Use of the lightning bolt to stop 
MIPs in process when user says to do it.  

● Another that has some benefit:  Option for automatic GDX file creation  
 

Things in Studio I wish would be improved 

Beauty is in the eye of the beholder and in my eye I think there is room to make some 
improvements.  I have been told some of these are in process (see the ** below).  In particular I 
would like to see in terms of: Elimination of option to hide command line box and run button**; 
Better implementing documentation view (as discussed below); Adding a solver option file 
editor**; Expanding capabilities of the GDX file viewer**; Putting in a choice or action to 
replace tabs with spaces when files are opened or when cut paste occurs; Providing less 
cumbersome access to McCarl guide; Adding a library of McCarl guide and User guide 
examples; Allowing one to hide some of the over supply of libraries in the Library Explorer as 
discussed above; Implementing something that could clean up extraneous files (Unneeded LXI, 
LST, LOG, 225a, GDX, and maybe put utility); Improving the documentation search so it can 
find more things (right now it fails to find refreader and <); and Improve the prioritization of 
search results as I find many to be irrelevant and that the important ones often appear lower in 
lists. 

Things that differ that I am unsure about: 

● Project files versus Explorer Groups 
 

2.8 A difficulty I had in using Studio 
I opened documentation access through Help and it docked the documentation window at the top 
of my screen with the top bar inaccessible. This made it impossible to use that bar to close or 
move the documentation window. Also I found that window was restricted to always be on top 
which located it in front of the Studio editing window so initially I could not access the rest of 
Studio.  Furthermore, I found that despite using the control f2 sequence discussed below that on 
my machine the docking that hides the top bar occurs every time I open the documentation and 
use a maximize command to make the document fall outside the Studio desktop.   In turn despite 
closing and reopening the Studio I initially could not figure out how to get rid of the 
documentation window, nor could I get into the editing part of the Studio. Later I figured out I 
could narrow the window from side to side until I could see the view tab and uncheck the view 
of the Help.  

Through GAMS support I was informed Control F2 resets the view closing the Help window 
which I now use.  I was also told running Studio with command line options like ​--​reset-view 
would work​ ​although I think this is not so useful as I believe it a rare user who wants to run 
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Studio through the command line.  I hope GAMS can fix this odd docking behavior.  I also find 
the documentation access to be rather awkward in its placement and docking behavior.  I find the 
help sometimes goes in the main Studio window and other times in a separate window 
sometimes in a strange place on the desktop without me having any way of knowing which will 
occur. Finally I feel that the desktop undocked documentation and other such windows should be 
set up so they are not always on top. 
 

2.9 Can we get better control over the font size on the documentation? 
My computer in native mode wants to use high resolution and the fonts are small. This makes the 
Studio documentation quite hard to read for my eyes. Unfortunately, changing the resolution and 
blowing up the font size through Windows display options leads to some weird behavior with 
some software.  For me I would like it if control + (really control = without the shift) would blow 
the font up in the documentation window like it does in browsers.  I did find control shift + 
worked but feel it would be nice if this followed the conventions in other programs.  
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3 Basic, Advanced and Combined courses offered soon 
This year I will again be teaching my family of GAMS courses for basic and advanced users. 
These courses will be offered in early June when there will still be some snow up in the high 
country and Arapahoe basin may even still be open for skiing.  Dates, times and content are 

● Basic to Advanced GAMS class June 24, 2019- June 28, 2019 (5 days) in the Colorado 
mountains at Dillon (near Frisco and Breckenridge). The course spans from Basic topics to 
an Advanced GAMS class. Details are found at 
https://www.gams.com/fileadmin/news-events/Basic_to_Advanced_GAMS_Modeling2019.p
df​ . 

● Basic GAMS class June 25, 2019- June 26, 2019 (3 days) in the Colorado mountains at 
Dillon (near Frisco and Breckenridge). The course starts assuming no GAMS background. 
Details are given at 
https://www.gams.com/fileadmin/news-events/Basic_GAMS_Modeling2019.pdf​ ​.  

● Advanced GAMS class June 26, 2019- June 28, 2019 (3 days) in the Colorado mountains at 
Dillon (near Frisco and Breckenridge). The course is for users who have a GAMS 
background. Details are found at 
https://www.gams.com/fileadmin/news-events/Advanced_GAMS_Modeling2019.pdf  

Further information and other courses are listed on ​http://www.GAMS.com/courses.htm​ . Note I 
also give custom courses for individual groups a couple of times a year.   
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4 Unsubscribe or subscribe to future issues of this newsletter 
Please unsubscribe through the web form available at: 
https://gams.us18.list-manage.com/unsubscribe?u=f1497c76718404eae593beb11&id=45ccea2ee
0  

  

Those who wish to subscribe to future issues can do this through the newsletter section of 
http://www.GAMS.com/maillist/index.htm​. 

This newsletter is not a product of GAMS Corporation although it is distributed with their 
cooperation.  

 

February 21, 2019 
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